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[bookmark: _Toc155100857][bookmark: _Toc157151175][bookmark: _Toc161701349][bookmark: _Toc165888110][bookmark: _Toc165888473][bookmark: _Toc165888577]Below is an alphabetical list of commonly used acronyms, initialisms, and terms used throughout this document:
· Armed Forces: The term “armed forces” means the Army, Navy, Air Force, Marine Corps, and Coast Guard as defined by Section 101 (a) (4) of the United States Code 
· BA/BS: Baccalaureate degree 
· CALPADS: California Longitudinal Pupil Achievement Data System
· CalWORKs: California Work Opportunity and Responsibility to Kids Program
· CAPSDAC: California Preschool Data Collection 
· CD: County-District code; used as part of the Preschool Code 
· CSPP: California State Preschool Program 
· CSV: Comma Separated Value, a file format 
· DLL: Dual Language Learner. Children who are learning two or more languages 
· EED: Early Education Division 
· FICN: Family Identification Case Number 
· FLI: Family Language Instrument 
· FLII: Family Language and Interest Interview 
· FTE: Full-time equivalency 
· HoH: Head of Household 
· IEP: Individualized Education Program 
· IFSP: Individualized Family Service Plan 
· LEA: Local Educational Agency 
· MA/MS/ME: Master’s degree 
· MB: Management Bulletin 
· Opportunity Program: An Opportunity Program is a supportive environment with specialized curriculum, instruction, guidance and counseling, psychological services, and tutorial assistance to help students overcome barriers to learning. It should not be viewed as a permanent placement for resistant learners but as a short-term intervention to ensure that students will succeed when they return to their regular classrooms.
· PhD/ EdD/MD: Doctorate degree 
· Report Period: Month and year of report. 
· SEID: California Statewide Educator Identifier 
· SMI: State Median Income 
· Vendor: Software vendor who has expressed interest in working with contracted agencies on the electronic reporting of the CAPSDAC Report 
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[bookmark: _Toc233708092]1.1	Introduction
The California Preschool Data Collection (CAPSDAC) is the California Department of Education (CDE)’s online system for collecting preschool classroom, staff, and child and other related information submitted by Local Educational Agencies (LEAs).
Assembly Bill (AB) 22 (Chapter 901, Statues of 2022) requires the CDE to collect the same data for children and staff in a LEA based California State Preschool Program (CSPP) that is collected from children and staff in the K–12 classroom setting. This was enacted in the California EC Section 60910, and requires the CDE, by July 1, 2024, to collect child and staff data for each child enrolled in a CSPP operated by an LEA, including all applicable data elements that are collected for children in transitional kindergarten (TK) pursuant to EC Section 48000. This data, in combination with the data collected pursuant to EC Section 60900, will provide longitudinal data for children enrolled in CSPPs operated by LEAs through grade 12. The CDE, Early Education Division (EED) developed the CAPSDAC online data system for this purpose. The information collected from these reports is used by state and federal legislators to develop public policy for early education services in California, and to request increased funds to expand program availability in unserved and underserved areas.
This manual is intended for authorized CAPSDAC users responsible for entering, uploading, reviewing, certifying, and maintaining California State Preschool Program data on behalf of a Local Educational Agency.
1.1.1	LEA Definition
LEA shall include a county office of education, a school district, or a charter school, as defined in EC Section 60900(k). A community college that operates CSPP is not included in this definition of LEA for purposes of submitting data to CAPSDAC.
1.1.2	Frequently Asked Questions
· What does the acronym CAPSDAC stand for?
The acronym CAPSDAC stands for California Preschool Data Collection, an online data collection system administered by the CDE to collect CSPP data. 
· Is participation in CAPSDAC mandatory? Which CSPP operators are required to submit data to CAPSDAC? 
Yes, participation in CAPSDAC is mandatory. Per EC 60910, the CSPP operators contracted with the CDE that are required to submit classroom, staff, and child data to the CAPSDAC system, CAPSDAC users, are LEAs defined by EC 60900 as a county office of education, a school district, or a charter school. 
· We operate both a CSPP and a California Department of Social Services (CDSS) Child Care and Development Program. Will we report the children enrolled in the CDSS program into the CAPSDAC as well? 
No, only children enrolled in CSPP will be reported into the CAPSDAC. Programs that are managed by the CDSS will report their children to the CDSS Child Development Management Information System (CDMIS). 
· Where will CSPP operators who are non-CAPSDAC users submit their data? 
Non-CAPSDAC users will continue to use both the CDE administered CDMIS and Preschool Language Information System (PLIS) to fulfill their CSPP reporting requirements. 
· Will we be responsible for reporting classroom, staff, and child records associated with preschool sites subcontracted by a Community-Based Organization (CBO) under our agencies' CSPP contract? 
Yes, contracted agencies are responsible for completing the monthly CAPSDAC data submission for CSPP classrooms, staff, and children for all sites that the agency contracts; this is inclusive of CBO preschools sites and Family Childcare Homes (FCCHs) subcontracted with the agency. 
· Does CDE plan to consolidate these different data systems (CDMIS, PLIS, and CAPSDAC) so that contractors only need to report to one place? 
Yes, the long-term goal is to have one system for reporting Child, Staff, and Classroom data, and the transition to CAPSDAC is a first step towards that goal. 
Please keep in mind that your California Preschool Accounting Reporting Information System (CPARIS) reporting is not affected by the launch of CAPSDAC. Reporting to CPARIS should continue as usual. 
· What kind of training will be available for CAPSDAC, and how do we access it? 
The CAPSDAC Support Team is committed to providing comprehensive training and support to CAPSDAC users. We will provide a detailed user manual that covers various aspects of the system, including navigation, user account management, manual records input, and electronic data file uploads. In addition to the user manual, we have published resources such as the CAPSDAC Data Submission Schedule, Comma Separated Values (CSV) Electronic Templates, and Webinar Slide Decks for reference and guidance. These resources are accessible on the CAPSDAC Support web page. Additionally, we have also conducted technical assistance webinars and in-person trainings to demonstrate how users can submit their data effectively, while sharing best practices along the way. There will be ongoing trainings/office hours after July 1, 2026. Furthermore, our team will actively monitor the CAPSDAC Online Support Portal and email inbox to address any questions or concerns, ensuring a smooth and efficient data submission process for everyone involved. 
· Will our Student Information Systems (SIS) be updated for the CAPSDAC data submission? 
Each CAPSDAC user needs to reach out directly to their software vendors to discuss updates to prepare for their CSPP data to be submitted to the CAPSDAC. We have been in constant communication with known software vendors and provided them with access to our webinars, CAPSDAC beta testing, in-person trainings, and posted resources. It is essential for each agency to ensure that their specific software vendor is aware of and prepared for the updates to CAPSDAC. This will facilitate a smooth and successful transition of data submission to the updated CAPSDAC. 
· In what order should CAPSDAC users enter records into CAPSDAC? 
CAPSDAC users are advised to enter records into CAPSDAC beginning with the Classroom data domain, then the Staff data domains, and finally the Child data domains. Please refer to the order for the CAPSDAC Data Fields and Domains on the CAPSDAC Planning Resources web page. This sequence ensures proper data organization and alignment with the system's architecture. 
· What if a child is dual enrolled in CSPP and Transitional Kindergarten (TK)?
If a child is dually enrolled in CSPP and TK, please follow all reporting requirements for each program type. 
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CAPSDAC Privacy Statement
All CAPSDAC users must agree to the CAPSDAC User Terms and Conditions by reading the enter statement and checking “Yes, I Agree to These Terms and Conditions” before entering the system. Below is the statement of terms and conditions: 
I, as a CAPSDAC User, am acknowledging the following information.
· I know, have been trained on, and follow the security and privacy policies and best practices at my local educational agency that are in place to protect the CAPSDAC data.
· I know and follow the security and privacy state and federal laws that are in place to protect CAPSDAC data, including but not limited to the Family Educational Rights and Privacy Act (FERPA), California Education Code §49060 – 49079, and California Civil Code §1798.29.
· I have a legitimate and authorized business need to access the data in CAPSDAC and will use this access only for legitimate and authorized business needs.
· If I suspect or detect a security or privacy violation, I will contact the CAPSDAC Support Team immediately, as well as inform my local educational agency in accordance with our policies.
· I have read, understand, and will comply with the following notice: “NOTICE - You are about to access the CAPSDAC data collection system of the California Department of Education (CDE). This system is intended for authorized users only, in accordance with the Confidentiality and Security Agreements for CAPSDAC Users, and applicable state and federal laws. Unauthorized access to or use of this system, or any information therein, is prohibited by CDE policy, the Confidentiality and Security Agreements for CAPSDAC Users, and applicable state and federal laws. Unauthorized access to this system, and/or unauthorized use of information from this system may result in civil and/or criminal penalties under applicable state and federal laws. By using this system, you acknowledge and agree that all information concerning your access to this system, including but not limited to any information entered, stored, or retrieved by you, may be monitored, retrieved, and/or disclosed by authorized personnel. This includes authorized network administrators and CDE personnel, for any lawful purpose, including but not limited to criminal prosecution.”
· I understand that I am responsible for the security and privacy of my password. I will adhere to the following minimum requirements for a password: It must be at least fifteen (15) characters in length and must include characters from three of the four categories: at least one uppercase letter, at least one lowercase letter, at least one number, and at least one of the following non-alphanumeric characters: ! ? @ # $ ^ & * − = _ +.
· I will comply with the following rules governing user credentials: I will protect my logon credentials at all times; I will never share my user ID and/or password with anyone; I will avoid using a feature in my local browser which automatically fills in passwords; I will not write my password down for myself or others' easy access. (If I need help remembering my password, I will use a secure password manager to store it safely.)
· I will protect CAPSDAC information in any form, including information contained on printed reports, data downloaded onto computers and computer media (e.g., compact discs, external drives, thumb drives, etc.), user computer monitors, or any other format. Data saved to portable storage devices, such as laptops, USB thumb drives, DVDs, and discs will be encrypted.
· I will logoff of CAPSDAC if I am going to be away from my computer, logoff of CAPSDAC or lock my computer before I leave it unattended, remove CAPSDAC media information from my desktop when I am away from my desk, store media containing CAPSDAC information in a locked container during non-business hours, properly cleanse or destroy media containing CAPSDAC information, and shred paper media and compact discs prior to disposal. I will ensure that the diskettes and other magnetic media are cleansed using appropriate software or a magnetic field with sufficient strength to render the information unreadable. I understand that simply deleting files from magnetic media does not remove the information from the media.
· I am aware of the security issues of data scraping, snooping, shoulder surfing, social engineering, faxing, virus scanning and patching, phishing, spear phishing, whaling, and I will prevent breaches from these issues to the best of my ability.
· All family, child, staff, and classroom information collected and submitted to the California Department of Education (CDE) is confidential and is restricted to purposes directly connected with the administration of my local educational agency's California State Preschool Program (CSPP). Only persons designated by the Superintendent and/or Principal may view this information, and these persons may only view the information for purposes directly connected with the administration of the program or except as provided by law. Editing of this information is limited to users designated by the Superintendent and/or Principal for purposes directly connected with the administration of the program. (5 CCR Section 17732).


[bookmark: _Toc233368420][bookmark: _Toc233708094]1.3	Signing in to CAPSDAC.
This section of the user manual provides users with instructions on how to access CAPSDAC and Sign in to the system.
1.3.1	Accessing the CAPSDAC
1. Open your web browser and navigate to the CAPSDAC website when it is time for CAPSDAC Monthly Certification.
2. You will be redirected to the Microsoft Sign in page, and will be asked to input your CAPSDAC Account Username and Password
1.3.2	Logging into CAPSDAC
1. Enter your credentials into the respective fields of the Microsoft Sign in interface.
2. Select the “Sign In” button to proceed.
3. Next, you will be directed to the Terms and Conditions webpage. Read and acknowledge the conditions by selecting, “Yes, I Agree to These Terms and Conditions” button at the bottom of the webpage.
Upon successful sign in, you will be directed to the CAPSDAC dashboard.


[bookmark: _Toc233368421][bookmark: _Toc233708095]1.4	CAPSDAC Monthly Certification
CAPSDAC Monthly Certification is the monthly reporting process used by LEAs to certify that submitted Classroom, Classroom Enrollment, Staff, Staff Assignment, Staff Classroom, Family, Child, Enrollment, Language Status, Supplemental Language, Education Program, Incident, Incident Result, and Attendance records are complete and accurate for the reporting period.


[bookmark: _Toc233368422][bookmark: _Toc233708096]1.5	CAPSDAC Dashboard
This section introduces the CAPSDAC Dashboard and describes its primary components and navigation features.
After signing in through Microsoft authentication, users are directed to the CAPSDAC Dashboard, the starting point for accessing all CAPSDAC functions.
The Dashboard provides a summary of the Local Educational Agency (LEA) information, quick access to system functions, certification status, and data submission progress. From this page, users can navigate record management, electronic file uploads, data exports, certification, and discrepancy resolution.
The dashboard also displays the current Academic Year, the user's LEA, and summary counts for Schools, Classrooms, Staff, and Children associated with the selected LEA.
1.5.1	Dashboard Header
The information displayed at the top of the Dashboard identifies the current reporting context.
1.5.1.1	Local Educational Agency (LEA)
The Local Educational Agency (LEA) specifies the educational agency for which the user is submitting data and can be found at the top of the webpage.
1.5.1.2	Academic Year
The Academic Year indicates the reporting year currently selected in CAPSDAC. All records entered, uploaded, certified, and exported are associated with the selected academic year.
1.5.1.3	User Account
The upper-right corner displays the signed-in user account and provides access to account-related options.
1.5.2	Dashboard Summary Tiles
The Dashboard displays summary tiles that provide a quick overview of the LEA's reported data.
	Tile
	Description

	Schools
	Total number of preschools associated with the LEA.

	Classrooms
	Total number of classroom records currently reported

	Staff
	Total number of staff records reported.

	Children
	Total number of child records reported.


These values are updated as records are entered or uploaded into CAPSDAC.
1.5.3	Navigation Menu
The navigation menu on the left side of the Dashboard provides access to all major CAPSDAC functions.
Available menu options include:
· Home – Returns to the Dashboard. 
· View/Update Records – Create, edit, search, and manage Classroom, Staff, and Child records. 
· File Upload – Upload Electronic Transfer Files (ETFs). 
· View Submissions – Review file upload status and validation results. 
· Discrepancies – Review and resolve Data Discrepancies (DDs). 
· Certification – Complete monthly certification after all Fatal discrepancies have been resolved. 
· Data Exports – Download Operational Data Store (ODS) reports and CSPPID data exports. 
1.5.4	Certification Cycles
The Certification Cycles section displays the status of each monthly certification period for the selected Academic Year.
For each certification cycle, the dashboard displays:
· Certification Status 
· Submission Deadline 
· Fatal Data Discrepancies 
· Warning Data Discrepancies 
Certification cannot be completed until all Fatal Data Discrepancies have been resolved.
1.5.5	Quick Search
The Quick Search panel allows users to locate records directly from the Dashboard without navigating to the View/Update Records pages.
Users may conduct a search for previously certified data using identifiers such as:
· CSPPID 
· CICN 
· Staff Local ID 
· SEID 
· Classroom ID 
After entering a search value, select the Search button to retrieve matching records.
Tips
· Complete Classroom records before entering Staff or Child records.
· Entering records in dependency order helps reduce validation errors and improves data integrity.
· Search for existing records before creating new ones to prevent duplicate CSPPIDs.
Important
Monthly certification cannot be completed until all Fatal Data Discrepancies have been resolved.


[bookmark: _Toc233708097]Chapter 2.		User Management
[bookmark: _Toc165971148][bookmark: _Toc179959016][bookmark: _Toc233378414][bookmark: _Toc233708098]2.1	Introduction
This chapter describes how to manage user accounts in the CAPSDAC system, including creating, updating, and removing user accounts, as well as assigning user permissions.
This has established two user accounts for each CSPP contracted by the LEA: one for the Program Director and one for the Executive Director. The Program Director and Executive Director are responsible for designating LEA personnel to submit and certify CAPSDAC monthly data submissions. 
Program Directors and Executive Directors are assigned Administrator accounts with the privileges needed to create user accounts, assign permissions, and deactivate users as needed.


[bookmark: _Toc233378415][bookmark: _Toc233708099]2.2	User Roles
CAPSDAC supports the following user roles, or account types:
[bookmark: _Toc233378416]Administrator
Administrators have full access to user management functions. They can create, edit, and remove user accounts, assign data access permissions, and grant additional system privileges as needed.
[bookmark: _Toc233378417]Regular User
Regular users have access only to the data and functions assigned by an Administrator. Their permissions are based on their assigned responsibilities within the LEA.


[bookmark: _Toc165888119][bookmark: _Toc165888482][bookmark: _Toc165888586][bookmark: _Toc179959017][bookmark: _Toc233378418][bookmark: _Toc233708100]2.3	Add User Accounts
CAPSDAC allows LEA Program Directors, Executive Directors, and other authorized administrators to create, edit, and deactivate user accounts for their LEA. Users with the appropriate permissions can add new CAPSDAC user accounts as needed.
[bookmark: _Toc233378419]2.3.1	Add a New User
[bookmark: _Toc233378420]2.3.1.1	To access CAPSDAC, users must sign in through Microsoft authentication. The Microsoft Sign in page is displayed automatically when you access the CAPSDAC online system. Enter the username and password, then select “Sign In” to continue. You must read and agree to the CAPSDAC Terms and Conditions before accessing your account.
2.3.1.2	Upon logging in to the CAPSDAC, the user should see the navigation pane on the left of the screen. To add or modify an account, locate and select the “User Management” button in the navigation pane.
2.3.1.3	The User Management page displays a search bar and information about existing user accounts in the LEA: “First Name”, “Last Name”, “Username”, and “Email.”
2.3.1.4	To add a user account, locate and select the “Add New User” button at the top-right corner of the page.
· The “Add New User” button will open a window to search for existing users by their “Username,” “First Name,” “Last Name,” or “Email” to avoid adding duplicate user accounts. There are two options for the search. Option 1 is for search by username. Option 2 is for search by first name, last name, and/or email.
· If any of the information inserted matches a user in the system, the table will display the “Username,” “First Name,” “Last Name,” and “Email” of the user/users. 
· If the information inserted does not find any matches or the correct person to add to the LEA, select the “Continue with New Record” button.
· Once an existing user in the system is selected or a new record is created, a new window will pop up to add the new user’s information including:
· Username
· First Name
· Last Name
· Email Address
· Phone Number
· The Data Access section allows administrators to assign View and Edit permissions for the following data areas:
· Child (CHLD)
· Language (LANG)
· Enrollment (ENRL)
· Staff (STFF)
· Staff Classroom (SCLR)
· Additional permissions that can be granted include:
· Extracts: allows the user to download CAPSDAC extract files.
· Certifier: allows the user to certify CAPSDAC data submissions.
· Reports (End of Year): provides access to end-of-year reporting functions.
· Reports (Fall): provides access to view fall certified reports.
· Reports (Monthly): provides access to view monthly certified reports.
· You can also use quick check buttons on the top right to grant “Full Access,” “All Edit,” “All View,” or “All Additional.”
· After entering the information, select “Create User.” A confirmation message indicates whether the user account was created successfully. If not, check the information you have entered and make appropriate edits and submit it again until the user account has been successfully created.
· Then navigate to the “User” screen, where the new user's information should appear in the “Account” and “User” tabs.
[bookmark: _Hlk105484512]If CAPSDAC users require further assistance, please submit a help request ticket through the CAPSDAC Customer Support Portal (link available at the bottom of each CAPSDAC screen) or email the CAPSDAC Support Office at CAPSDAC@cde.ca.gov.
For LEAs that have no admin users due to changes in both program director and executive program director, please submit a request for new account via the CDE CAPSDAC New Account Request Form.


[bookmark: _Toc165888121][bookmark: _Toc165888484][bookmark: _Toc165888588][bookmark: _Toc179959018][bookmark: _Toc233378421][bookmark: _Toc233708101]2.4	Edit User Accounts
[bookmark: _Toc233378422]2.4.1	Edit User Information
CAPSDAC allows administrators to update user account information as needed.
· On the “User Management” User screen, Administrators can select a user to modify the information, including:
· Personal Information: If “Personal Information” is edited, select “Update Profile” to save the changes.
· Data Access: Select the appropriate access permissions for the user's responsibilities.
· Additional Permissions: Select any additional permissions required for the user.
· After completing all updates, select “Save Permissions.”


[bookmark: _Toc233378423][bookmark: _Toc233708102]2.5	Remove User Access
CAPSDAC allows Administrators to remove user access within their LEA.
· On the “User Management” User screen, select a user to open the user's account management screen.
· Scroll to the bottom of the page to find the “Remove Access” button on the left and select the red “Remove Access” button. 
· After selecting Remove Access, a confirmation message appears stating: 
“This action removes all permissions for the selected user within the LEA. This action cannot be undone.”
· [bookmark: _Toc165888124][bookmark: _Toc165888487][bookmark: _Toc165888591][bookmark: _Toc157151213][bookmark: _Toc14684287][bookmark: _Toc161701373][bookmark: _Toc157151214]If “Remove Access” is selected in the confirmation window, the user will lose all access to the LEA.


[bookmark: _Toc233708103]Chapter 3.		Manual Input/Edit Instructions
[bookmark: _Toc160801692][bookmark: _Toc213856530][bookmark: _Toc75021966][bookmark: _Toc233708104]3.1	Introduction
This chapter provides step-by-step wizard for using the Manual Input/Edit Data Entry feature in CAPSDAC 2.0 to support certification, compliance, and reporting for the CSPP.
Manual Input/Edit applies the same business rules and validation logic as electronic Comma-Separated Values (CSV) file submissions and writes data directly to the CAPSDAC Operational Data Store (ODS).
[bookmark: _Toc213856543][bookmark: _Toc160801707]This document focuses exclusively on manual entry. 


[bookmark: _Section_D:_Data][bookmark: _Toc1294448390][bookmark: _Toc233708105][bookmark: _Toc213856548]3.2	Inquiry Screens on All Record Types
This section describes how to use the CAPSDAC Manual Input/Edit feature to search for and view existing CAPSDAC records in read-only mode without initiating edits. The inquiry functionality supports review, verification, and reconciliation activities and does not modify data stored in CAPSDAC.
Best Practice: Always use the Inquiry function before adding new records to prevent duplicates and ensure identifier consistency.
[bookmark: _Toc397706452]3.2.1	Accessing Inquiry Screens
Steps:
1. Log into the CAPSDAC Online Portal.
2. Select View/Update Records.
3. Select the appropriate data option (classroom, staff, or child).
[bookmark: _Toc812667642]3.2.2	Searching for Records
Use Quick Search Function in the Main Menu
Steps:
1. In the CAPSDAC main menu, below Quick Search, select a search type from the dropdown menu (CSPPID, CICN, SEID, Staff Local ID, Classroom ID).
2. Enter the search criteria.
3. Select Search.
View Record List or Use Search Function on Class, Staff, Child Data Screens
Steps:
1. Select the submenu under the View/Update Records, i.e., select Staff Data.
2. A search screen is displayed on the top of the screen. A list of records is displayed at the bottom of the screen.
3. Select the Program Year from the dropdown menu and enter the information you are searching for or select the record from the list below and select the record.
[bookmark: _Toc1143246486]3.2.3	Reviewing Results
Steps:
1. Review the summary grid.
2. Apply filters as needed.
3. Select a record to open it in inquiry mode.
4. Select the tab associated with the record to view more information. For example, a staff (STFF) record also populates Staff Assignments (SASS) and Staff Classroom (SCLR).


[bookmark: _Toc213856532][bookmark: _Toc1744462716][bookmark: _Toc233708106]3.3	Manual Input/Edit Data Entry
[bookmark: _Toc213856534]This section describes CAPSDAC Manual Input/Edit general rules, system behavior, validation rules, and the procedures for entering, updating, and reviewing CAPSDAC records using Manual Input/Edit Data Entry in CAPSDAC Online Portal.
[bookmark: _Toc193273817]3.3.1	Overview
Manual Input/Edit Data Entry allows LEAs to create, update, and maintain CAPSDAC records directly in CAPSDAC using structured on-screen forms.
Records entered manually are validated in real time and are subject to the same certification and compliance requirements as electronic file submissions. Records with unresolved Fatal Data Discrepancies cannot be certified.
[bookmark: _Toc1262986157]3.3.2	General Requirements
The following requirements apply to all Manual Input/Edit Data Entry activities:
· Users must be authorized and logged in.
· Correct Program Year and Preschool must be selected.
· All required fields must be completed.
· Data must conform to CAPSDAC data definitions and code sets.
[bookmark: _Toc921212732][bookmark: _Toc213856537]3.3.3	Manual Input Categories
There are three categories of manual input:
· Classroom Data
· Staff Data
· Child Data
Each record has multiple tabs that allow users to input all required information to populate the following record types:
	Number
	Code
	Record Type

	1
	CLRM
	Classroom

	2
	STFF
	Staff

	3
	SASS
	Staff Assignment

	4
	SCLR
	Staff Classroom

	5
	CHLD
	Child

	6
	FAMI
	Family

	7
	LANG
	Language

	8
	SLNG
	Supplemental DLL

	9
	ENRL
	Enrollment

	10
	CLEN
	Classroom Enrollment

	11
	ATTN
	Attendance

	12
	PRGM
	Education Programs

	13
	CINC
	Incident

	14
	CINR
	Incident Result


Note: ATTN, PRGM, CINC, and CINR record types will be released in a future phase and are not included in this document.
[bookmark: _Toc907138479]3.3.4	Entering Records Using Input/Edit
Steps:
1. Log into the CAPSDAC Online Portal.
2. Select View/Update Records.
3. Select the appropriate categories: Classroom Data, Staff Data, or Child Data.
4. Select Add to create a new record, or select the record listed on the screen to edit it.
5. Enter all required fields.
6. Review all entered information before saving.
7. Select Save.
Note: Records cannot be saved if required fields are missing or invalid.
[bookmark: _Toc213856541][bookmark: _Toc2048077033][bookmark: _Toc160801706]3.3.5	What Happens After You Save
[bookmark: _Section_C:_Data]System Processing Indicator
· After you select Save, Submit, or Update, a yellow Processing status appears in the upper-right corner of the screen.
· A green status indicates the record was successfully processed.
· A red status indicates processing failure, and corrections are required before proceeding.
Refer to Section 5.5, Certification Requirements, for additional information on resolving Data Discrepancies before certification.
[bookmark: _Toc1710088107]3.3.6	Editing and Deleting Records
Note: Edit and delete functionality is record-type specific and may be restricted based on CAPSDAC policy, record status, certification state, and user permissions.
[bookmark: _Toc232143900]3.3.7	Best Practices 
· Enter records in dependency to prevent certification delays and ensure compliance with CDE reporting requirements.
· Enter records in the following dependency order to minimize validation errors and certification delays:
· Classroom Data → Staff Data → Child Data
Review Data Discrepancies (DDs) daily during active data entry periods. Refer to Section 5.7, Discrepancies Resolution, for additional information on resolving Data Discrepancies before certification.
· Verify all identifiers using the Inquiry functions.
Tip: Search for an existing record before creating a new one to prevent duplicate records. Search by Classroom ID, Staff Local ID, CSPPID, CICN, or the First Name, Last Name and Date of Birth if creating a new Record.

[bookmark: _Toc1736341580][bookmark: _Toc233708107]3.4	Manual Entry — Classroom Data
This section describes how to use the CAPSDAC Manual Input/Edit to create, update, and review Classroom data using Manual Input/Edit Data Entry.
The Add Classroom screen provides a step-by-step wizard. The exact steps displayed may vary depending on your agency’s configuration and the data entered, but commonly include those detailed in the following sections.
Tip: Required fields must be completed before you can proceed. Use the question mark (?) tooltips next to fields for definitions and guidance. Select Previous to return to earlier steps if edits are needed.
[bookmark: _Toc753627962]3.4.1	Add a New Classroom Record
Steps:
1. Log into the CAPSDAC Online Portal.
2. Select View/Update Records in the main menu, select Classroom Data.
3. Select Classroom Data.
4. Select the Add Classroom button on the upper-right corner of the screen.
· Under Classroom Information section
· Select Program Year and Preschool.
· Enter Classroom ID.
· Enter or select Effective Start Date.
· Enter the Classroom Name.
· Under Classroom Details section
· Select Volunteer Frequency.
· Select the Program Type.
· Select Contract Types.
· Select Setting Types.
· Select Program Durations.
· Select the Language Program Type.
· Select Yes or No for Mental Health Consultation services (MHCS) from the dropdown menu.
· Select Language(s) Used in Classroom.
· Select Save.
[bookmark: _Toc1172389987]3.4.2	Editing Existing Classroom Record
Steps:
1. In the CAPSDAC main menu, select View/Update Records.
2. Select Classroom Data.
3. Enter Classroom information to search for the record, 
OR
Select an existing Classroom record listed in the second half of the screen. 
4. There are three tabs for Classroom data: CLRM, SCLR, and CLEN. 
5. Select the appropriate tab for editing, and then select the class record.
6. A popup screen of Edit Classroom Record allows users to edit the specific record type of the classroom. Enter the appropriate edits.
7. Select Update. 
Required Fields:
· Program Year
· Preschool
· Classroom
· Effective Start Date
[bookmark: _Toc1089657503]3.4.3	Delete an Existing Classroom Record
This section explains how to delete an existing CLRM, SCLR, or CLEN record using the Manual Input/Edit Data Entry feature. Deleting a record permanently removes all associated data from the system for the selected Program Year.
Steps:
1. In the main CAPSDAC menu, select View/Update Records and select Classroom Data.
2. Locate the Classroom record either by searching or selecting the record from the list displayed on the second half of the screen.
3. On the Classroom records screen, there are three tabs associated with the classroom record: CLRM, SCLR, and CLEN. Select the specific record type you want to delete. 
4. Select the record showing on the bottom half of the screen to bring to a popup screen for editing or deleting.
· Confirm that the information displayed is correct.
· Select the red Delete button to delete the record.
· Select Cancel to exit without deleting or select Delete to confirm deletion.
Note: Edit and delete functionality is record-type specific and may be restricted based on CAPSDAC policy, record status, certification state, and user permissions.
[bookmark: _Toc222182504]3.4.4	Best Practices for Entering Classroom Data
· Use a consistent Classroom ID across all related CAPSDAC record types.
· Enter classroom records before entering enrollments and classroom enrollments.
· Refer to Section 5.5, Certification Requirements, for certification requirements related to Data Discrepancies. 
[bookmark: _Toc1886379800][bookmark: _Toc233708108]3.5	Manual Entry — Staff Data
This section describes how to use the CAPSDAC Manual Input/Edit to create, update, and review staff data. The staff data will populate the following domains: STFF, SASS, and SCLR.
The Add Staff screen provides a step-by-step wizard. The exact steps displayed may vary depending on your agency’s configuration and the data entered, but commonly include those detailed in the following sections.
Tip: Required fields must be completed before you can proceed. Use the question mark (?) tooltips next to fields for definitions and guidance. Select Previous to return to earlier steps if edits are needed.
[bookmark: _Toc1181279150]3.5.1	Adding a New Staff Record
Steps:
1. Log into the CAPSDAC Online Portal.
2. Select View/Update Records in the main menu, select Staff Data.
3. Select the Add Staff button located on the upper-right corner of the screen.
4. Search Tab
· Before adding a staff member, search the system to determine whether an existing record already exists. The Search for Staff page allows you to search by Staff Local ID or by first and last name and date of birth.
· If the search returns no match, select Continue with New Record to create a new staff record.
5. Staff Demographics Tab
· Under the Staff Information section.
· Review the accuracy of the staff’s first and last name and birthday. Enter the staff’s middle name. Select the staff’s gender, ethnicity, race(s), language(s) proficiency, and highest degree completed. Under the Employment Information section.
· Select Yes or No for the staff’s permit/credential waiver. 
· If a Yes on Waiver is selected, enter or select Waiver Issued Date and waiver Expiration Date. Select a waiver type from the dropdown menu.
· If a “No” is selected for Waiver, select the permit/credential type from the dropdown menu. Enter the Permit or Credential Number, Permit Issuance Date, and Permit Expiration Date.
· Enter Current Employment Start Date, Current Employment End Date if applicable, and Overall Employment Start Date.
· Select Next.
6. Staff Assignment Tab
· Under Staff Information section 
· Select a Preschool for the staff.
· Confirm that pre-populated Program Year and Staff Local ID are accurate. 
· Under Classroom Roles section
· Select the staff roles 1 and 2 from the dropdown menu and enter the percentage of each role. 
· Under Non-Classroom Roles section
· Select the staff roles 1 and 2 from the dropdown menu and enter the percentage of each role.
· Select Next. 
7. Staff Classroom Tab	
· Under Classroom section
· Make sure pre-populated Preschool, Program Year, and the Staff Local ID are accurate.
· Enter the Classroom ID.
· Select Next.
8. Review & Submit Tab
· Review each section and make edits as needed by selecting Edit for the appropriate section. 
· After confirming all information is correct, select Submit.
Note: The system processes the record after submission. Do not close the browser window during processing. Once processing is complete, the record becomes available in the summary grid.
[bookmark: _Toc502616546]3.5.2	Edit an Existing Staff Record
Steps:
1. In the CAPSDAC main menu, select View/Update Records.
2. Select Staff Data.
3. Enter the staff’s information to search for the record, 
4. OR
Select an existing Staff record listed in the second half of the screen and select Edit to update the record. 
5. There are three tabs for staff data: STFF, SASS, and SCLR. Select the appropriate tab for editing, and then select the Staff Record.
6. A popup Edit Staff Record screen allows users to edit the specific record type. Enter appropriate edits.
7. Select Update.
Note: The system processes the record after submission. Do not close the browser window while processing is in progress. Once processing is complete, the record becomes available in the summary grid.
[bookmark: _Toc1357680586]3.5.3	Delete an Existing Staff Record
This section explains how to delete an existing STFF, SASS, and SCLR using the Manual Input/Edit Data Entry feature. Deleting a record permanently removes all associated data from the system for the selected Program Year.
Steps:
1. In the CAPSDAC main menu, select View/Update Records and select Staff Data.
2. Locate the Staff record either by searching or selecting the record from the list displayed on the second half of the screen.
3. On the Staff Records screen, there are three tabs associated with the Staff record: STFF, SASS, and SCLR. Select the specific record type you want to delete. 
4. Select the record displayed in the bottom half of the screen to open the popup screen for editing or deleting.
5. Confirm that the information displayed and recorded is correct.
6. Select the red Delete button to delete the Record.
7. Select Cancel to exit without deleting or select Delete to confirm deletion.
Note: Edit and delete functionality is record-type specific and may be restricted based on CAPSDAC policy, record status, certification state, and user permissions.
[bookmark: _Toc551090482]3.5.4	Best Practices for Entering Staff Data
· Enter Staff records before entering Staff Assignment or Staff Classroom records.
· Use consistent identifiers (Local Staff ID/SEID) across related records.
Refer to Section 5.5, Certification Requirements, for certification requirements related to Data Discrepancies.
Tip: Search for an existing record before creating a new one to prevent duplicate records.
[bookmark: _Toc1386748919][bookmark: _Toc233708109]3.6	Manual Entry — Child Data
This section explains how to use the CAPSDAC Manual Input/Edit to create, update, and review Child Data using Input/Edit (Manual) Data Entry. Use this process when you need to add a new Child record or update Child information directly in the CAPSDAC.
A manual input child record will populate the following domains associated with the child: CHLD, FAMI, LANG, SLNG, ENRL, and CLEN.
The Add Child screen provides a step-by-step wizard. The exact steps displayed may vary depending on your agency’s configuration and the data entered, but commonly include:
Tip: Required fields must be completed before you can proceed. Use the question mark (?) tooltips next to fields for definitions and guidance. Select Previous to return to earlier steps if edits are needed.
[bookmark: _Toc1439655944]3.6.1	Adding a New Child Record
Steps:
1. Log into the CAPSDAC Online Portal.
2. Select View/Update Records.
3. Select the Add a Child button.
4. Search Tab
· Before adding a child, you must search the system to see if the child has an existing record. The Search for a child page allows you to search for the child either by inputting their CSPPID or first and last name as well as date of birth. 
· If the search does not return to a match, select Continue with New Record to create a new Child record.
· OR 
· Select an existing Child record and Select Edit to update the record.
5. Basic Information Tab
· Under the Agency Information section
· Enter the Effective Start Date (the date the agency enters the record).
· Select the Program Year.
· Select the Preschool from the dropdown list.
· Enter Local Child ID (CICN).
· Enter the SSID if the child has one.
· Under the Child Information section 
· Enter the child’s first, middle, and last names.
· Select the appropriate suffix if applicable.
· Select the child’s birth country, state, and city.
· Entering the Date of Birth.
· Select the child’s gender.
· Select the child’s ethnicity, race, and IEP/IFSP status.
· Select Next.
6. Family Information Tab
· If the family information is not available, you can check Enter this record later to temporarily bypass the Family tab.
· Under the Family Information section
· Enter Effective Start Date, the date this record is entered (today)
· Enter Family Local ID (FICN), Family size, Family Monthly Income, and select CalWORKs Recipient status from the dropdown menu.
· Enter first and second Head of Household (HoH)’s first, middle, and last names; select the Reason(s) for Needing Service and the appropriate Highest Education level from the dropdown menus.
· Select written and verbal communication preferences for the family from the dropdown menus. To quickly locate a language, type the first letter of the language in the dropdown list to bring the appropriate language to the top of the menu.
· Under the Address Information section
·  Enter Address Line 1, Line 2 if needed, and City; select State from the dropdown menu and enter Zip code.
· If the mailing address differs from the home address, select the appropriate option to display the mailing address fields. Enter the mailing address.
· Select Next.
7. Language Tab
· Review the Agency Information displayed at the top of the screen. Ensure that the CSPPID, Effective Start Date, Program Year, Preschool, and Local Child ID (CICN) are accurate.
· On the Language Information section, select the appropriate Instrument Opt Out response.
· Enter the Instrument Date if No is selected.
· Enter the Language(s) Heard, Understood, and Spoken. Multiple language selections are allowed.
· Select Yes or No for the DLL Instrument Designated field.
· If DLL Instrument is selected as “No,” indicates whether the child is DLL designated by a teacher in the DLL Teacher Designated field.
· If DLL Teacher Designated is Yes, enter the date of designation in the DLL Teacher Designated Date field. 
· Select Next.
8. Supplemental DLL Tab
· Make sure the CSPPID, Effective Start Date, Program Year, Preschool and Local Child ID (CICN) are accurate.
· Under the Language information section, select the appropriate Interview Home Language(s) and Interview Most Used Language from the dropdown menus. The Interview Home Language(s) field can accept up to five language codes. The Interview Most Used Language field allows only one selection.
· Select Next.
9. Enrollment Tab
· Make sure the CSPPID, Local Child ID (CICN), Program Year, and Preschool information are accurate.
· Enter Contract Type, Program Type, Program Duration, and Eligibility Status from dropdown menus. 
· Enter or select Enrollment Start Date. 
· Enter or select Enrollment End Date and select Enrollment Exit Code from the dropdown menu if applicable.
· Select Next.
10. Classroom Enrollment Tab
· Make sure the Program Year, Preschool, CSPPID, and Local Child ID (CICN) are accurate.
· Enter Classroom ID, Enrollment Start Date, Enrollment End Date if applicable.
· Select Next.
11. Review & Submit Tab
· Review the information you have entered in each section, select Edit if a correction is needed, make sure all the information is correct before selecting the Submit button.
Note: The system processes the record after submission. Do not close the browser window while processing is in progress. Once processing is complete, the record becomes available in the summary grid.
[bookmark: _Toc1270621313]3.6.2	Edit an Existing Child Record
Steps:
1. In the CAPSDAC main menu, select View/Update Records > Classroom Data.
2. Select Child Data.
3. Enter the child’s information for a search record.
OR
Select an existing Child record listed.
4. After the Child Record appears on the screen, select the record. There are five tabs for the child: CHLD, FAMI, LANG, SLNG, ENRL, and CLEN. Select an appropriate tab for editing, and then select the record.
5. Enter the appropriate edits.
6. Select Update.
[bookmark: _Toc1563902133]3.6.3	Delete an Existing Child Record
This section explains how to delete existing CHLD, FAMI, LANG, SLNG, ENRL, or CLEN records using the Manual Input/Edit Data Entry feature. Deleting a record permanently removes all associated data from the system for the selected Program Year.
Steps:
1. In the CAPSDAC main menu, Select View/Update Records and select Child Data.
2. Locate the child’s record either by searching or selecting the record from the list displayed on the second half of the screen.
3. On the Child Records screen, there are 6 tabs associated with the child’s record: CHLD, FAMI, LANG, SLNG, ENRL, and CLEN. Select the specific record type you want to delete.
4. Select the record showing on the bottom half of the screen to bring to a popup screen for editing or deleting.
5. Select the red Delete button to delete the record.
6. Select Cancel to exit without deleting or select Delete to confirm deletion.
Note: Edit and delete functionality is record-type specific and may be restricted based on CAPSDAC policy, record status, certification state, and user permissions.
[bookmark: _Toc1454050874]3.6.4	Best Practices for Entering Child Data
· Maintain consistent identifiers (CSPPID, SSID, CICN, FICN).
· Create Family records before linking a Child to a Family.
· Resolve Child-related DDs before entering Enrollment or Classroom Enrollment.
Tip: Search for an existing record before creating a new one to prevent duplicate records.



[bookmark: _Toc1494839204][bookmark: _Toc233708110]3.7	Data Validation and Data Discrepancies for Manual Input/Edit Data Entry
This section explains how CAPSDAC Online Portal applies validation rules to records entered through Manual Input/Edit to ensure data accuracy, completeness, and consistency. These validations help identify missing, invalid, or conflicting data and support LEAs in resolving issues prior to monthly certification.
Records entered manually through Input/Edit are subject to the same intra-file and inter-file validation rules as electronic file submissions. Validation messages and DDs are generated to assist users in correcting data issues.
[bookmark: _Toc777651511]3.7.1	Intra-File and Inter-File Validation Rules
CAPSDAC validation rules fall into two categories:
Intra-file validations check the structure and content of a single record entered through Input/Edit. These validations ensure that:
· All required fields are populated.
· Data values conform to format and length requirements.
· Codes entered are valid for the selected record type.
· Dates fall within allowable ranges.
Records that fail intra-file validation cannot be saved. Users must correct all errors before the system allows the record to be stored.
Inter-file validations check consistency across related record types after records are saved. Examples include:
· Child must be linked to an existing Family record.
· Enrollments must reference a valid Child and Classroom.
· Child assignments must reference an existing Child record.
· Language Status and Supplemental DLL records must correspond to an existing Child.
Inter-file issues generate DDs for review but do not necessarily prevent records from being saved.
[bookmark: _Toc586540100]3.7.2	Understanding Data Discrepancies (DDs)
DDs are validation issues identified after records have been successfully saved through Input/Edit but contain inconsistencies across related data.
DDs help LEAs identify and resolve data issues, including:
· Missing dependent records
· Conflicting dates or codes
· Locating mismatched identifiers
· Resolving logic conflicts across record types
DDs are categorized by severity, such as:
· Fatal – Must be resolved before certification.
· Warning – Should be reviewed but may not block certification.
Certification Requirement
· All Fatal DDs must be resolved before monthly certification.
· Records with unresolved Fatal DDs will prevent certification from completing successfully.
[bookmark: _Toc751290605]3.7.3	User Access and Roles for Managing Data Discrepancies
Access to DDs is controlled by CAPSDAC security roles to ensure data integrity, policy compliance, and certification of readiness.
Roles and Responsibilities
· LEA Administrator Role (ADMIN): Manages user accounts and assigns security roles within CAPSDAC. Ensures that appropriate staff have access to view and edit records and resolve Data Discrepancies.
· Edit Role (e.g., CHLD Edit): Enters and updates CAPSDAC records using Manual Input/Edit Data Entry. Resolves Data Discrepancies by correcting records in accordance with CAPSDAC data definitions and validation rules.
· View Role (e.g., CHLD View): Reviews records and Data Discrepancies in read-only mode for monitoring, reconciliation, and audit preparation. Does not modify records.
Tip: Only users with an Edit role may update records to resolve Data Discrepancies. Only users with appropriate authorization may perform actions that affect certification of readiness.
[bookmark: _Toc1095464834]3.7.4	Navigating and Resolving Data Discrepancies
Steps: 
1. Navigate to Data Discrepancies.
2. Review discrepancy details by selecting specific errors.
3. Identify the affected record.
4. Navigate to View/Update Records.
5. Locate the related record.
6. Select the record to edit.
7. Correct the data.
8. Select Update.
9. Confirm that the discrepancy is resolved via View Submissions or Data Discrepancies.
[bookmark: _Toc1729504540]3.7.5	Ongoing Validation and Best Practices
The Data Discrepancies validation process runs automatically throughout the day as records are added or updated through Manual Input/Edit Data Entry.
[bookmark: _Toc1511715650]3.7.6	Best Practices
· Request exports only after resolving all Fatal Data Discrepancies.
· Allow processing time after editing before requesting an export.
· Use exports to reconcile local systems prior to certification.
· Retain exports for audit and compliance documentation.


[bookmark: _Toc1968557730][bookmark: _Toc233708111]3.8	Download Operational Data Store (ODS) Data Exports for Manual Input/Edit Data Entry
This section explains how to use the CAPSDAC Online Portal Data Exports function to request and download Operational Data Store (ODS) Data Export reports for records entered or maintained through Manual Input/Edit Data Entry in CAPSDAC Online Portal.
ODS exports provide LEAs with a point-in-time snapshot of data stored in CAPSDAC at the time the export job is processed. These exports support internal review, reconciliation, and preparation for certification.
[bookmark: _Toc1172694950]3.8.1	Download — Request ODS Data Report
Use this process to request and download an extract of ODS data for a selected Program Year and one or more Preschools.
ODS Data Exports are available for the following record types:
· Classroom Record (CLRM)
· Staff Record (STFF)
· Staff Assignment Record (SASS)
· Staff Classroom Record (SCLR)
· Child Record (CHLD)
· Family Record (FAMI)
· Language Record (LANG)
· Supplemental DLL Record (SLNG)
· Enrollment Record (ENRL)
· Classroom Enrollment Record (CLEN)
Note: ODS exports reflect a snapshot of data at the time the export request is processed. Recently entered or updated records may not appear immediately.
Steps: 
1. Log into the CAPSDAC Online Portal System.
2. Navigate to Data Exports → ODS Data Exports.
3. Select the Record Type (For example: CHLD, STFF, CLRM).
4. Filename (recommended)—Enter a clear filename including LEA name, record type, Program Year, and date. (For example: LEAName_STFF_20252026_20260201).
5. Select the Program Year from the dropdown menu.
6. Select one or more Preschools (multi-select supported).
7. (Optional) Email Address—Enter an email address to receive notification when the extract is ready.
8. Select the Request Export.
9. After processing is completed, the file will appear in the ODS Exports list below as “Complete.” Download the file as needed.
[bookmark: _Toc627465123]3.8.2	Best Practices 
· Refer to Section 5.5, Certification Requirements, for certification requirements related to Data Discrepancies.
· Use consistent identifiers (CSPPID, SSID, Local IDs, FICN, Classroom ID, Staff ID) across related record types.
· Allow sufficient processing time after Manual Input/Edit updates before requesting an export.
· Retain copies of exported files for internal review and certification support.


[bookmark: _Toc1854715744][bookmark: _Toc233708112]3.9	CSPPID Data Export
This section describes how to request and download a CSPPID Data Export from the CAPSDAC Online Portal system.
The CSPPID Data Export provides LEAs with a file containing CSPPIDs generated and maintained in CAPSDAC, which may be used to support local system integration, reconciliation, and reporting activities.
Below is the CSPPID Data Export Table Layout:
	Field
	Type
	Example

	File Type
	Char
	CSPPID-R

	    Reporting LEA Code
	Char
	1910199

	Preschool Code
	Char
	1437190

	Program Year
	Char
	2025–2026

	CSPPID
	Char
	66V364TJVW

	CICN
	Char
	12345686

	Child First Name
	Char
	Royce

	Child Middle Name
	Char
	Z

	Child Last Name
	Char
	He

	Child Name Suffix
	Char
	Jr

	Child DOB
	Char
	20220115

	Child Gender
	Char
	F

	Effective Start Date
	Date
	20250701

	Effective End Date
	Date
	NA



[bookmark: _Toc222182526][bookmark: _Toc451803370]3.9.1	Download — Request CSPPID Data Export
This section describes how to use the CAPSDAC Online Portal Manual Input/Edit to request and download a CSPPID Data Export for a selected Program Year and one or more Preschools.
The CSPPID Data Export produces a CSV file containing CSPPIDs associated with children reported in CAPSDAC for the selected criteria.
Steps: 
1. On the CAPSDAC main menu, Select Data Exports.
2. On the Data Exports screen, select the Data Exports tab.
3. Select the CSPPID Data Export tab. 
4. Filename (recommended)—Enter a clear filename including LEA name, record type, Program Year, and date. (For example: LEAName_CSPPID_20252026_20260201). This field is optional.
5. Select the Program Year from the dropdown menu.
6. Select one or more Preschools (multi-select supported).
7. (Optional) Email Address—Enter an email address to receive notification when the extract is ready.
8. A list of reports will appear on the second half of the screen. Select the appropriate file and scroll to the right to see the Status column. Select the download sign to download the file.
9. Open the downloaded CSV file in Excel and save it onto the designated drive/file folder.
[bookmark: _Toc33667904]3.9.2	Best Practices for CSPPID Data Export
· Verify the correct Program Year and Preschool selections before requesting the export.
· Allow sufficient processing time after Manual Input/Edit updates before requesting the export.
· Retain downloaded CSPPID files for local system loading, reconciliation, and audit support.
· Use CSPPID values consistently across related CAPSDAC record types (for example: Child, Enrollment, Classroom Enrollment).
· [bookmark: _Section_G:_Best][bookmark: _Appendix:_Appendix:_File][bookmark: _Appendix:_File_Statuses][bookmark: _Electronic_File_Submission]Review CSPPID data in conjunction with ODS exports and DDs to ensure identifier accuracy prior to certification.
· See Section 4.5 for Data Discrepancies requirements related to certification readiness.
[bookmark: _Toc157151217][bookmark: _Toc161701377][bookmark: _Toc165888142][bookmark: _Toc165888505][bookmark: _Toc165888609]

[bookmark: _Toc233708113][bookmark: _Toc214374077]Chapter 4	Electronic File Upload Instructions
[bookmark: _Toc233708114]4.1	Introduction
This chapter provides technical specifications and instructions for preparing and uploading CAPSDAC electronic files.


[bookmark: _Toc214374078][bookmark: _Toc233708115]4.2	Background
Agencies maintaining a CSPP contract with the CDE, EED may utilize the Electronic File Upload of the CAPSDAC Online Portal to fulfill the CAPSDAC Monthly Certification requirement.


[bookmark: _Toc214374079][bookmark: _Toc233708116]4.3	Uploading Electronic Files
This section provides step-by-step wizard for Local Educational Agencies (LEAs) to upload Electronic Transfer Files (ETFs) to the California Preschool Data Collection Online Portal. The upload process applies to the following 14 required record types:
· Classroom
· Classroom Enrollment
· Staff
· Staff Assignment
· Staff Classroom
· Family
· Child
· Enrollment
· Language Status
· Supplemental DLL
· Education Program (To Be Released Later)
· Incident (To Be Released Later)
· Incident Result (To Be Released Later)
· Attendance (To Be Released Later)
Note:
Before uploading new files, always save a copy of the most recent successful upload for backup purposes.
[bookmark: _Toc213856533][bookmark: _Toc214374080]4.3.1	Overview of the File Upload Process
The EFT process is the primary method for uploading Preschool data to CAPSDAC Online Portal. Files must be prepared in Comma-Separated Value (CSV) format. Templates can be downloaded from the CDE CAPSDAC Planning Resources for Upcoming Release web page. CAPSDAC Online Portal automatically validates the uploaded files. If validation errors occur, the upload will fail and errors must be corrected before resubmission.
[bookmark: _Toc214374081]4.3.2	Understanding Upload Rules and Processes
[bookmark: _Toc213856535][bookmark: _Toc214374082]4.3.2.1	Log In
1. Access the CAPSDAC Online Portal at: .
2. Log in using your assigned credentials.
3. Review and accept the Privacy Statement to continue.
[bookmark: _Toc213856536][bookmark: _Toc214374083]4.3.2.2	Ensure Upload Meets Requirements
· All uploads occur at the LEA level; site-specific uploads are not supported at this phase.
· Ensure your CSV files comply with specifications and business rules referenced in CAPSDC Data Domains and Fields and CAPSDAC Code Sets.
· This process allows LEAs to report Child, Staff, and Classroom records for all Preschools in one upload. Files must be in CSV format and can be prepared using Microsoft Excel or similar software. 
· Each row represents an entity record (e.g., a child, staff member, or classroom) and each column corresponds to a data field (e.g., Child ID, Preschool CDS Code, Program Code). 
· Required fields must be completed; optional fields may remain blank. Always use valid codes from CAPSDAC Code Sets (e.g., Language Code, Program Type Code).
[bookmark: _Toc214374084]4.3.3	Working with the File Upload Template
[bookmark: _Toc213856538][bookmark: _Toc214374085]4.3.3.1	Complete the Template
1. Navigate to the CAPSDAC Online Portal Support Webpage and download the CAPSDAC File Upload Template.
2. Open the worksheet tab that corresponds to the file type you are preparing. For example, if you wish to enter data for classroom, select on the “Classroom.”
3. Begin entering Row 2, which is the row right below the header row. Each cell contains guidance indicating whether the field is required or optional, along with built-in validations.
4. Save the file to your local drive. Make sure you select the CSV file format.
[bookmark: _Toc214374086]4.3.3.2	Make a Copy of the File
1. Right select on the file tab in which you have completed data entry; select “Move or Copy.”
2. On the pop-up menu, select on the “To book” dropdown menu, select (New book) and check the “Create a copy” box. Then select on “OK.”
3. You will see a new Excel file with a single tab of the file you have completed.
4. Delete Row 1 (the field name row).
[bookmark: _Toc213856539][bookmark: _Toc214374087]4.3.3.3	Save the CSV File
1. Go to File > Save As.
2. Enter a file name, change the file type from Excel Workbook (*.xlsx) to CSV(Comma delimited) (*.csv) and select Save.
3. Save the file to your local drive.
4. Upload the CSV file to the CAPSDAC website.
Note:
· Do not change the column order.
· Do not add extra formatting such as colors, filters, or merged cells.
[bookmark: _Toc214374088][bookmark: _Toc213856540]4.3.4	Retrieve the LEA and Preschool codes.
1. From the navigation menu, select Data Exports → ODS Data Exports.
2. Set Record Type to Currently Active Preschools.
3. Filename and Email Address fields are optional.
4. Select the Request Extract button.
5. Wait until the status in the table shows “Complete.”
6. Download the CSV file.
7. In the CSV, the number following School-Beta is the LEA code, and the number at the end of the string is the Preschool code.
[bookmark: _Toc214374089]4.3.5	Upload a File
1. Select “File Upload” on the CAPSDAC navigation menu.
2. On the right of “Selected Files,” select “Browse Files” to select your CSV file or drag and drop it into the upload area.
3. CAPSDAC will automatically detect the file type. If it does not, use the dropdown menu to manually select the correct file type.
4. Select “Submit Files” to upload.
5. To monitor progress, select “View Submissions” from the navigation menu.
[bookmark: _Toc214374090]4.3.6	Validation and Error Handling
1. After submission, CAPSDAC validates each uploaded file automatically.
During submission, CAPSDAC automatically updates the file status to reflect each validation stage or any authorized user actions (e.g., posting or rejected).
2. Files may appear under one of the following statuses:
· Failed – Upload was unsuccessful. Reformat the file and retry or contact CAPSDAC Support.
· Posted – Records passed all validations and were committed to the database.
· Rejected – File uploaded successfully but failed input validation. View the number of errors and select the file to bring a pop-up screen showing the details of errors. Make corrections accordingly and re-upload the file.
3. To view the progress of the uploaded file:
· Select the “View Submission” or scroll down the page to see Submitted Files.
· Each row displays a file upload status, file name, record type, upload date, uploaded by whom, the number of errors, and the number of records.
· Select any place in the row to view the details of submission. In the case of a file is rejected, it shows details of each error. Carefully read the error code and error message to make the data correction.
· Resolve all issues before resubmitting.
4. A file may fail due to intra-file validation issues. When this occurs, CAPSDAC will display the following message:
“The upload encountered one or more errors.”
To review and resolve these errors:
· Select “View Submission” or scroll down the “File Upload” page.
· The Validation Summary page will appear, displaying three sections:
· Percentage of Errors: Shows the proportion of records that contain validation errors.
· Count of Errors: Indicates the total number of errors identified in the uploaded file.
· Error Details: Provides a detailed description of each specific error encountered during validation.
5. No data is committed until all errors are resolved.
6. View the Error on the CAPSDAC System, correct the issues in your CSV file, and re-upload.
7. If issues persist, contact CAPSDAC Support by selecting the CAPSDAC Customer Support Portal link at the bottom of the page and submitting a ServiceNow ticket.


[bookmark: _Toc214374091][bookmark: _Toc233708117]4.4	Data Exports 
Data Exports allows LEAs to extract their data directly from the Operational Data Store (ODS). An LEA may request an extract of the current data contained in the ODS for each record type previously submitted to the CAPSDAC. These files can be used to compare and identify differences between data stored in CAPSDAC and the data maintained in a local student information system.
[bookmark: _Toc213856544][bookmark: _Toc214374092]4.4.1	Downloading CSV Files
Note: ODS extract files are refreshed throughout the day and reflect the most current data available.
[bookmark: _Toc213856545][bookmark: _Toc214374093]4.4.1.1	File Format
ODS extract files are generated in CSV format. The structure of each file follows CAPSDAC’s standard order and data type specifications. Date fields adhere to the required CAPSDAC File Format (CCYYMMDD, e.g., 20251001).
[bookmark: _Toc213856546][bookmark: _Toc214374094]4.4.1.2	File Export
LEAs may request ODS Extract files for any record type via the CAPSDAC Online Portal. The ODS Extract feature allows authorized users to specify selection criteria, when applicable, and request that a file be generated by CAPSDAC. The completed file will be made available for secure download within the system. For data security, ODS extracts should be stored in the LEA’s secured system.
Steps:
1. Log into the CAPSDAC Online Portal.
2. Navigate to Data Exports → ODS Data Exports.
3. Select the desired Record Type from the “Record Type” dropdown menu. 
4. Enter the desired Filename. This field is optional.
5. Select the Program Year from the dropdown menu.
6. Select the Preschool if it is applicable. By default, all Preschools are selected. To manually select multiple Preschools, hold the “Control” key and select on the desired options.
7. Enter an email Address if you’d like to be notified when the extract is ready. This field is optional.
8. Select on “Request Export.”
9. Wait a few seconds to see the file show up under the “ODS Exports” list. Once the status shows Complete, download the ODS Data Extract file as needed.
Note:
· Do not open the downloaded file using Microsoft Excel.
· Open an Excel file and get the data From Text/CSV by selecting on the “Data” menu and then selecting on “From Text/CSV” to bring the data into the Excel file.
· Check to see if there are any leading “0” being dropped and reformat the file to make sure leading “0” are showing if you would like to edit the file and resubmit it.

[bookmark: _4.5_Data_Discrepancies][bookmark: _Toc214374095][bookmark: _Toc233708118]4.5	Data Discrepancies (DDs)
CAPSDAC Online Portal applies two types of validation rules to uploaded files: inter-file and intra-file validation. Understanding these validation processes helps Local Education Agencies (LEAs) ensure that their CAPSDAC Monthly Certifications are complete, accurate, and consistent across all file types.
[bookmark: _Toc213856549][bookmark: _Toc214374096]4.5.1	Inter-file and Intra-file Validation Rules
· Inter-file Validation: These rules check for consistency across multiple files within a submission. Files that trigger inter-file validation errors are still accepted but flagged for review. These errors appear in the Data Discrepancies section for users to address later.
For example: In the “Family” file, if the ‘FamilySize’ field is 1, the Head of Household #1 name must match the Child name.
· Intra-file Validation: These rules validate the internal structure and content of each individual file, including required fields, data formatting, and value constraints. Files that fail intra-file validation are rejected on the View Submission screen.
For example: In the “Family” File, MailingAddressZip is not a valid Zip Code. It must be in the format 12345 or 12345-6789.
[bookmark: _Toc213856550][bookmark: _Toc214374097]4.5.2	Understanding Data Discrepancies
Data Discrepancies (DDs) are validation issues triggered by records that have been successfully posted to CAPSDAC but contain errors or inconsistencies. They differ from submission errors, also known as Intra-file Validation Rules (IVRs), which prevent files or transactions from being accepted.
Key Points:
· DDs are triggered dynamically as data changes and are not dependent on nightly batch processing.
· Unresolved fatal DDs evolve into Certification Data Discrepancies (CDDs), which appear on the Snapshot Detail screen.
· The Data Discrepancies window allows users to preview potential CDDs for upcoming submissions (e.g., Fall 1 or End-of-Year) before the snapshot revision period begins.
[bookmark: _Toc213856551][bookmark: _Toc214374098]4.5.3	User Access and Account Roles
LEA-level users must have appropriate security roles to access and manage DDs in CAPSDAC:
· Any Role – Grants basic access to the Data Discrepancies screen. Users can navigate to the page but view limited data unless assigned a specific View role.
· Edit Role – file-specific – Grants full access to view summary counts, explore record details, and download discrepancy extract files for designated file types.
[bookmark: _Toc213856552][bookmark: _Toc214374099]4.5.4	Navigating the Data Discrepancies Interface
Access the Data Discrepancies from the CAPSDAC navigation menu on the left screen. After selecting your criteria, select on “Apply Filters” to view the results.
[bookmark: _Toc214374100]Screen Overview
The Data Discrepancies screen is divided into three key sections:
1. Search / Selection Filters – Located at the top and used to refine results.
Note:
· Some filters (e.g., Certification Cycle or Academic Year) may not show all values to optimize performance.
2. Summary Grid (Error Counts by Code) – Displays a summary of triggered errors after filters are applied.
· Error codes are listed with counts.
· Each error code includes a hyperlink to the CAPSDAC Support page for more information.
3. Display Grid – Lists individual discrepancy records with sortable headers and links to data points.
· Select on “View” to open a detailed record and troubleshoot the issue.
Always verify that the correct Academic Year and Certification Cycle are selected before filtering to ensure accurate results.
[bookmark: _Toc213856553][bookmark: _Toc214374101]4.5.5	General Data Discrepancies Process
The DD validation process runs automatically against ODS data throughout the day.

[bookmark: _Toc213856554][bookmark: _Toc214374102][bookmark: _Toc233708119]4.6	Tables File Status and Type Codes
[bookmark: _Toc213856556][bookmark: _Toc214374103]4.6.1	Electronic File Record Type Codes
	Record Type
	Code

	CLRM
	Classroom

	STFF
	Staff

	SASS
	Staff Assignment

	SCLR
	Staff Classroom

	CHLD
	Child

	FAMI
	Family

	LANG
	Language

	SLNG
	Supplemental Language DLL

	ENRL
	Enrollment

	CENR
	Classroom Enrollment

	ATTN
	Attendance

	PRGM
	Education Programs

	CINC
	Incident

	CINR
	Incident Result


[bookmark: _Toc214374104]4.6.2	Electronic File Submission Status
	Process Phases
	Status
	Definition

	File Upload & Preparation
	Created
	File upload was successful; validations have not run on the data yet.

	File Upload & Preparation
	Failed
	File upload was not successful; the system did not receive the file. The user needs to reformat the file or reach out to customer service for assistance.

	File Upload & Preparation
	Standardizing
	Converting to batch file.

	File Upload & Preparation
	Standardized
	File converted.

	File Upload & Preparation
	Staging
	File is in staging database and is processing.

	File Upload & Preparation
	Staged
	File has been processed in staging database. Once the file is posted, the staged data is purged.

	File Input Validations
	Validating
	Data is being validated through IVR processes.

	File Input Validations
	Validated
	File has been processed; user can review errors.

	File Input Validations
	Posting
	Records are posting to database.

	File Input Validations
	Posted
	Records are posted - data have passed all input validations and the records are committed to the database.

	File Input Validations
	Rejected
	File uploaded successfully but triggered full rejection when file input validations were executed. The file input validation errors should be resolved before data is resubmitted.




[bookmark: _Toc233708120][bookmark: _Toc233628365]Chapter 5	Certification
[bookmark: _Toc233708121]5.1	Introduction
Certification in CAPSDAC Online Portal is the formal process by which LEAs validate, review, and approve submitted data for reporting and compliance purposes. Certification ensures that data is complete, accurate, and aligned with established validation rules for each reporting cycle.
This chapter provides a comprehensive, operational guide to Certification in CAPSDAC Online Portal. It is designed to support program staff, reviewers, certifiers, coordinators, and support personnel in understanding how certification functions within the system and how it aligns with broader CDE data governance practices.

[bookmark: _Toc233708122]5.2	Purpose and Certification Workflow
This  section provides step-by-step instruction for LEA users to complete certification tasks in CAPSDAC Online Portal. It is intentionally structured to go beyond a high-level overview and instead provide practical, step-based guidance for the LEA users performing certification-related tasks.
The chapter supports LEA users in:
· Understanding the purpose and structure of the Certification
· Navigating CAPSDAC certification-related pages
· Interpreting validation results and discrepancy outputs
· Performing data correction tasks
· Preparing data for certification approval
· Aligning CAPSDAC processes with California Longitudinal Pupil Achievement Data System Certification Status expectations
In CAPSDAC, certification represents the point at which data has been sufficiently reviewed and is considered ready for formal approval within a defined collection cycle. Therefore, LEA users must understand not only where certification occurs in the system, but also the sequence of actions required to reach certification readiness.


[bookmark: _Toc233708123]5.3	Alignment with California Longitudinal Pupil Achievement Data System Certification Model
CAPSDAC Online Portal aligns conceptually with the California Longitudinal Pupil Achievement Data System (CALPADS) Certification Status framework while using a different interface and terminology. Key concepts carried forward include:
· Certification based on cycle-level readiness.
· Separation of blocking errors and non-blocking warnings
· Role-based responsibilities (data entry, reviewer, certifier)
· Requirement for data validation prior to certification
· Importance of auditability and traceability
The Certification pages provide status information, while data validation and correction are completed through the Data Discrepancies page.


[bookmark: _Toc233708124]5.4	Certification Workflow
5.4.1	Current CAPSDAC Implementation Context
The CAPSDAC system provides the core components required to support certification readiness. The certification workflow guides users through validating, reviewing, and preparing data for certification.
As a result, the current certification workflow relies heavily on the Data Discrepancies page for active data validation and correction, while the Certification pages serve as status and navigation references.
The Certification function is accessible from the left navigation panel and includes:
· Current Cycle (active certification context) 
· List of Cycles (historical and multi-cycle view) 
At present, LEA users should understand the system behavior as follows:
· The Certification pages provide cycle-level status and navigation. 
· The Data Discrepancies page serves as the primary workspace for validation and correction. 
· Users achieve certification readiness by resolving all blocking discrepancies.
As a result, certification is currently a process-driven workflow, supported by multiple system components rather than a single interface.
5.4.2	Certification as a Process
Certification in CAPSDAC Online Portal is a structured, multi-phase process designed to ensure that submitted data is:
· Complete 
· Accurate 
· Consistent across records 
· Ready for audit and reporting 
The certification lifecycle consists of the following phases:
Phase 1. Data Entry and Maintenance
Users enter and maintain data throughout the reporting cycle.
Phase 2. Validation and Discrepancy Generation
The system applies validation rules and generates two types of errors:
· Blocking errors (must be resolved) 
· Warnings (should be reviewed) 
Table 1 shows the severity of errors.
Table 1. Error Severity Table
	Error Type
	Description
	Required Action

	Blocking Error
	Prevents certification
	Must be resolved

	Warning
	Does not block certification
	Should be reviewed


Phase 3. Discrepancy Review and Correction
Users review validation results and correct data through record updates or resubmissions.
Phase 4. Readiness Verification
Reviewers confirm that:
· All blocking errors are resolved. 
· Remaining warnings are acceptable. 
· Data is complete and reasonable. 
Phase 5. Certification Approval
Authorized certifiers have final approval once all requirements are met.
5.4.3	Certification Step-by-Step wizard
The following steps describe the end-to-end certification workflow:
Steps:
1. Confirm Organization Context
Sign in to CAPSDAC and verify the correct organization in the top banner.
2. Review Navigation Structure
Locate key workflow areas:
· View/Update Records 
· View Submissions 
· Data Discrepancies 
· Certification 
3. Access the Current Cycle page.
Navigate to Certification → Current Cycle to access the Current Cycle.
4. Review Cycle Navigation
Open Certification → List of Cycles to understand available reporting cycles.
5. Navigate to Data Discrepancies
Use the Data Discrepancies page as the primary workspace for validation.
6. Confirm Discrepancy Freshness
Review the Last discrepancy check timestamp and ensure data is current.
7. Review Error Summary
Use summary sections to understand:
· Volume of errors 
· Types of discrepancies 
8. Prioritize Issues
Focus on discrepancies based on:
· Severity (blocking vs warning, see Table 1) 
· Number of affected records 
9. Review Record-Level Details
Use the Errors by Record table to examine affected data.
10. Apply Filters
Use filters to isolate specific issues and improve efficiency.
11. Assigning Responsibility
Determine which staff role is responsible for resolving each issue.
12. Correct Data
Update records via:
· View/Update Records 
· Submission workflows 
13. Save or Resubmit
Ensure changes are saved or resubmitted.
14. Recheck Discrepancies
Return to Data Discrepancies and confirm resolution.
15. Repeat Until Resolved
Continue until all blocking errors are cleared.
16. Perform Reviewer Verification
A reviewer confirms readiness and completeness.
17. Review Cycle-Level Status
Return to Current Cycle to confirm readiness.
18. Complete Reports and Checks
Review reports, summaries, and support outputs.
19. Certifier Approval
Certifier performs final approval (when available).
20. Retain Documentation
Maintain records for audit and future reference.
5.4.4	Certification Workflow Diagram
Data Entry → Validation → Discrepancies → Correction → Review → Certification


[bookmark: _5.5_Certification][bookmark: _Toc233708125]5.5	Certification 
5.5.1	Current Cycle
The Current Cycle page provides a dashboard view of certification readiness for the active reporting cycle.
This page allows users to:
· Monitor validation status. 
· Review summary metrics. 
· Access supporting workflow components. 
Use this page as a checkpoint to assess readiness, not the primary location for data correction. See Section 5.5 for certification workflow overview.)
5.5.1.1	Certification Summary Fields
The Current Cycle displays the following fields:
· Total Errors – Blocking validation errors 
· Warnings – Non-blocking issues 
· Certification Step – Current workflow stage 
· Last Review Date – Most recent review activity 
· Last Reviewer – User who last reviewed data. 
Users should prioritize resolving Total Errors before proceeding.
5.5.1.2	Steps:
1. Sign in and confirm organization shown on the top banner.
2. Navigate to Certification → Current Cycle.
3. Confirm cycle name.
4. Review summary metrics.
5. Determine readiness status.
6. If needed, return to Data Discrepancies for corrections.
5.5.1.3	Supporting Tabs
The Current Cycle includes the following tabs:
· Revisions – Dataset versions and history 
· Validations – Error summaries and details 
· Reports – Certification reports 
· Submission – Submission status and deadlines 
· Lifecycle – Certification activity history 
Each tab supports a different stage of the certification workflow.
A. Validations Tab
Steps:
1. Select the Validations tab.
2. Review Error metrics:
· All
· Fatal Errors
· Warnings
· Statewide Student Identifier (SSID) Errors
· # of Multiple Identifiers (MID)
3. Review the Error Details table, including:
· Record ID 
· Record Type 
· Error Code
· Error Messages
4. Use this tab to understand validation results at a summarized and record-specific level before returning to Data Discrepancies for correction work.
B. Revisions Tab
Steps:
1. Select the Revisions tab.
2. Review the “Most Recent Revision” section, including numbers of:
	Metric
	Description

	Fatal Errors
	Blocking validation errors

	Warnings
	Non-blocking validation issues

	SSID Errors
	SSID synchronization issues

	MID Errors
	Multiple Identifier Discrepancies


3. Review the Locked Revision section to determine whether a revision has been locked.
4. If applicable, use the “Lock This Revision” function when the dataset is finalized.
5. Review the revision history, including:
· Activity Date
· Revision Create Date
· Revision Status
· Total Records
· Total Errors
C. Reports Tab
Steps:
1. Select the Reports tab.
2. Review the list of available aggregate reports.
3. Select a report, for example:
· Monthly Child Enrollment by Program Type 
· Monthly Child Enrollment by Statutory Age 
· Monthly Child Enrollment by Contract Type 
For details, please see Chapter 6.3, Generating Reports
4. Review the generated reports.
5. Use reports to verify counts, trends, and completeness prior to certification.
D. Submission Tab
Steps:
1. Navigate to the lifecycle or submission view (via tab or page anchor).
2. Review LEA and certification information:
· LEA name
· LEA code
· Certification cycle
3. Enter certifier information.
· First name
· Last name
· Email
· Phone Number
· Extension if applicable
4. Read the message: “On behalf of the Superintendent of the district and/or Principal of charter school, I certify that the data submitted is complete, true, and accurate to the best of my knowledge.”
5. Confirm you agree the certification statement.
6. Select “Certify” button to complete the certification. Certification Lifecycle Tab
· Review lifecycle information such as:
· Certification activity history
· Submission status
· Use this section to understand:
· Whether the cycle is still editable
· Whether deadlines or amendment windows have passed.
5.5.1.4	Operational Guidance for Current Cycle
· Use Current Cycle as a status dashboard. 
· Perform corrections in Data Discrepancies 
· Use Reports to verify data completeness. 
· Use Lifecycle to track certification status. 
5.5.2	List of Cycles
The List of Cycles page provides a table of available certification cycles.
This page supports:
· Cycle selection 
· Timeline awareness 
· Navigation across reporting periods
5.5.2.1	Certification Summary Fields
The list of certification cycles includes the following columns:
· Submission Cycle 
· Submission Type 
· Program Year 
· Deadline 
· Amendment Deadline 
Viewers can use filters to sort the list accordingly.
5.5.2.2	Steps:
1. Navigate to Certification → List of Cycles.
2. Review available cycles.
3. Apply filters as needed.
4. Select a cycle.
5. Navigate to cycle details.
5.5.2.3	Operational Guidance
· Use List of Cycles to understand timelines. 
· Use Current Cycle for readiness status. 
· Use Data Discrepancies for correction work.
5.5.2.4	Key Relationship Between Pages
· List of Cycles → Cycle selection
· Current Cycle → Status monitoring
· Data Discrepancies → Detailed correction 
Users should move between these pages to complete certification.
5.5.2.5	Certification Statuses and Working Definitions
· Open – Current Cycle
· In Review – Under review 
· Uncertified – Not yet approved. 
· Certified – Approved 
· Decertified – Reopened 
· Closed – No longer editable. 
5.5.2.6	Recommended Operating Practices
· Perform regular data maintenance. 
· Review discrepancies frequently. 
· Conduct pre-certification cleanup. 
· Document reviewer and certifier actions. 
· Monitor post-certification changes.
Note: The Fall Certification and End-of-Year (EOY) Certification sections are currently under development and will be added to a future release of the CAPSDAC User Manual after the certification processes and requirements have been finalized.


[bookmark: _Toc233708126]5.6.	Match Tool (CSPPID Matching and Validation)
5.6.1	Overview
The Match Tool is used to determine whether a child already exists in the CAPSDAC system and to assign or confirm the correct CSPPID (California State Preschool Program Identifier).
This process is critical to:
· Prevent duplicate child records. 
· Maintain consistent child identification across LEAs. 
· Ensure accuracy in statewide reporting. 
The Match Tool supports the following functions:
· Uploading files for batch matching.
· Searching for existing records (LEA and statewide). 
· Reviewing potential matches .
· Selecting the correct CSPPID.
Users must carefully review all matching results before selecting a CSPPID. Incorrect selection may result in data integrity issues across systems.
[bookmark: _Toc233628378]5.6.2	Accessing the Match Tool
The Match Tool is located within the Child Data section.
5.6.2.1	Navigation Steps
View/Update Records > Child Data > Match Tool
5.6.2.2	Instructions Panel 
The Match Tool includes an instructions panel that outlines the matching process that includes the following sections:
1 Understanding the process 
2 Creating the upload file 
3 Uploading file(s) 
4 Retrieving results 
Users should review these instructions before beginning the matching process by selecting the “>” icon to expand the instruction content.
[bookmark: _Toc233628379]5.6.3	Match for Multiple Record(s) for One Child
Users can search for a child through the entire CAPSDAC system. The search is not limited by LEA or Global. For a single CSPP ID search, select Add Child at the top of the page to open the search screen. Users may search using either Option 1: Enter the child's CSPP ID, or Option 2: Enter the child\’s First Name, Last Name, and Date of Birth.
[bookmark: _Toc233628380]5.6.4	Match for More than One Child’s Records
The Match Tool supports multiple child record search, also called batch matching through file upload.
Steps:
1. Prepare a Comma-Separated Values (CSV) file containing Child data. Use the Child file template to include children’s first and last names, dates of birth, agency and school codes, and reporting year. 
2. Upload the file by dragging and dropping or selecting Browse Files.
3. Confirm the file appears in the upload area.
4. Select Submit Files.
Submitted Files Section Displays
· File Name 
· Date Submitted 
· Submitted By 
· Number of Errors (if any) 
· Number of Records 
· Status
[bookmark: _Toc233628381]5.6.5	Reviewing Matching Results
After the file is processed, matching results are available in the Submitted Files section.
Steps:
1. Locate the submitted file.
2. Open the results.
3. Review potential matches for each record.
Each match may include:
· CSPPID 
· Match Score 
· LEA Information 
· Child Demographic Details 
Review Steps:
1. Select only a posted file and download the file.
2. Open the file and select “do not convert” for next use of the file format.
3. Review the match results (Column AB) to see results.
[bookmark: _Toc233628382]5.6.6	Selecting the Correct CSPPID
Steps:
1. Review all potential matches.
2. Compare demographic and identifying information.
3. Identify the best match.
4. Select the correct CSPPID.
Only select a CSPPID when you are confident the record represents the same child.
[bookmark: _Toc233628383]5.6.7	Matching Rules
· Only one CSPPID may be determined per child. 
· Do not select a CSPPID if the match is uncertain. 
· If no match exists, allow the system to generate a new CSPPID. 
· Always verify demographic fields before confirming a match 
· Do not rely on match score alone; review all fields

[bookmark: _5.7._Discrepancy_Resolution][bookmark: _Toc233708127]5.7.	Discrepancy Resolution Workflow
5.7.1	Overview
The Discrepancy Resolution Workflow provides a structured process for reviewing, correcting, and resolving data discrepancies in CAPSDAC Online Portal.
This workflow is a required component of certification preparation. All blocking errors must be resolved before certification can proceed.
Discrepancy resolution is an iterative process, requiring users to move between validation screens and record edit pages until all issues are cleared.
[bookmark: _Toc233628386]5.7.2	Discrepancy Resolution Screen Flow
The workflow follows a consistent sequence:
Steps:
1. Data Discrepancies Message Screen
Review:
· Error Code 
· Error Message 
· Record identifiers 
2. Primary Record Screen
Review the record generating the discrepancy.
3. Related Errors Screen
Identify additional errors associated with the same record.
4. Edit Record Screen
Update fields based on validation requirements.
5. Return to Discrepancy Screen
Refresh and verify resolution.
This process may repeat multiple times for a single record.
[bookmark: _Toc233628387]5.7.3	Starting from the Data Discrepancies Page
The Data Discrepancies page can be accessed from the CAPSDAC home by selecting “Data Discrepancies” on the navigation pane. The Data Discrepancies page provides a record-level view of validation results. There are three tabs on the Data Discrepancies page:
· Data Discrepancies 
· SSID Sync 
· Multiple Identifier (MID) Discrepancies 
Users should carefully review the error message before making changes.
5.7.3.1	Discrepancies
The Data Discrepancies tab displays record-level validation errors, including:
· Record ID
· Record Type
· Error Code
· Error Message
5.7.3.2	SSID Sync
The SSID Sync process validates child SSIDs submitted in CAPSDAC against CALPADS staging data. During certification, CAPSDAC compares child demographic and IEP/IFSP information against records available in the CALPADS ELAS and SPED files.
If mismatches, missing records, or unresolved synchronization issues are identified, CAPSDAC generates SSID discrepancy errors. These discrepancies need to be reviewed and resolved to ensure data quality.
LEAs and reporting agencies should review SSID discrepancies regularly during the certification cycle to ensure:
· Child SSIDs are valid and active in CALPADS.
· IEP/IFSP statuses align with CALPADS SPED records.
· Enrollment effective dates are consistent with CALPADS timelines.
· Overnight synchronization processing has been completed successfully.
Accessing SSID Sync Discrepancies
To review SSID discrepancy errors:
Steps:
1. Open the record listed in the Discrepancies table by selecting the record.
2. Read the error message(s)
Below are the possible errors:
· The child’s SSID is not valid.
· The child’s SSID cannot be found in CALPADS.
· The child’s SSID was found in CALPADS, but the IEP/ISFP status does not agree with the child record.
3. Collaborating with LEA’s CALPADS Staff to Resolve the CAPSDAC and CALPADS Data Discrepancies Issues
4. Update the Child Record in CAPSDAC or CALPADS. 
If it is determined that the child record needs to be updated in CAPSDAC. Select Update Record on the SSID Sync page to open the Edit Child Record window. Made the appropriate edits and select “Save.” 
[bookmark: _Toc233628388]5.7.4	Important Processing Rule
Resolving one discrepancy may trigger additional validation errors.
This occurs when:
· Related fields must also be updated. 
· Additional validation rules apply. 
Users must continue the correction process until all blocking errors are resolved.
[bookmark: _Toc233628389]5.7.5	Practical Correction Pattern
The recommended workflow:
Review → Open → Analyze → Edit → Save → Refresh → Recheck → Repeat.
Continue until:
· Errors are cleared. 
· Records are accurate. 
· No new blocking errors remain.
[bookmark: _Toc233628390]5.7.6	Integration with Certification Workflow
Discrepancy resolution directly determines certification readiness.
Before certification, users must:
· Resolve all blocking errors before certification. 
· Confirm that updated records are saved. 
· Verify consistency across related records.
[bookmark: _Toc233628391]5.7.7	Discrepancy Resolution Cycle
Review Error → Open Record → Fix → Save → Refresh → Recheck → Repeat 

[bookmark: _Toc233708128]5.8	Multiple Identifier Discrepancies (Multiple CSPPID Resolution)
5.8.1	Overview of MID Discrepancies
The MID Discrepancies page supports the identification and resolution of Multiple CSPPID (MID) errors. These errors occur when a child is associated with more than one CSPPID across records or across Local Educational Agencies (LEAs).
MID discrepancies typically indicate:
· Potential duplicate child records 
· Cross-agency data conflicts 
· Inconsistent child identification 
Resolving MID discrepancies is critical to maintaining data integrity, accurate reporting, and proper child identification across the CAPSDAC system.
The MID workflow allows LEA users to:
· Identify potential duplicate CSPPID records. 
· Compare records across LEAs. 
· Determine whether records represent the same child. 
· Resolve discrepancies through Merge or Not Match actions. 
MID discrepancies should be reviewed alongside Data Discrepancies as part of certification preparation.
[bookmark: _Toc233628394]5.8.2	Multiple Identifier Discrepancy Summary Page
The MIDs screen is the third tab on the Discrepancies page. Users can access this screen by selecting Discrepancies from the navigation menu and then selecting the MIDs tab.
The MID Discrepancy Summary page provides a centralized workspace for reviewing, filtering, and resolving MID discrepancies.
The MIDs page includes:
· Last discrepancy check timestamp 
· MID filtering controls 
· MID summary results table 
· Access to MID detail and resolution pages 
Last Discrepancy Check Timestamp
The Last discrepancy check timestamp appears in the upper-right corner of the page and indicates when MID discrepancy information was most recently refreshed by the system. Users should review this timestamp to ensure they are working with the most current discrepancy data.
5.8.2.1	Filter Controls
Users can refine results using the following filters:
· MID Type 
· All 
· External 
· Internal
· MID Status 
· All 
· Unresolved 
· Unresolved (Inactive) 
· Merged 
· Not a Match 
· No Longer Used 
· CSPPID 
· The CSPPID filter allows users to search for a specific child identifier.
· After entering filter criteria, select Search to display matching results.
· To remove all selected filters and return to the default view, select Clear.
5.8.2.2	Multiple Identifier Records Table
The Multiple Identifiers table displays MID records that match the selected filter criteria.
The table includes the following information:
· MID Type 
· MID Status 
· Original CSPPID 
· Potential Duplicate CSPPID 
· Child Identification Case Number (CICN or Child local ID)
· Child Name 
[bookmark: _Toc233628395]5.8.3	Multiple Identifier Resolution Actions
To review a MID discrepancy, select the desired row from the table.
The selected record opens the MID window. There are two tabs in this window: Details and History. The Details tab displays the original child record with original CSPPID column on the left and Potential Duplicate record on the right. The History tab provides the history of MIDs associated with this child. 
After having carefully reviewed the original and potential duplicate records and determined that this is a duplicate record, the user can select Merge Records.
5.8.3.1	Reviewing Multiple Identifier Details
Steps:
1. Select an unresolved MID record from the MID Records table.
2. Review the information displayed on the Details tab.
The Details tab presents a side-by-side comparison of the Original CSPPID and the Potential Duplicate record.
3. Compare the following identifying fields:
· CSPPID 
· CICN 
· LEA 
· Preschool 
· Program Year 
· Child Name 
· Gender 
· Date of Birth
4. Review any highlighted values displayed by the system.
Highlighted fields indicate differences between the Original CSPPID record and the Potential Duplicate record and should be reviewed carefully before acting.
5. Determine whether the records represent:
· The same child and should be merged, or 
· Different children should be marked as Not a Match.
6. Review all available information before selecting a resolution action.
Users should verify identifying information carefully because MID resolutions may affect child records across agencies.
5.8.3.2	History Tab
The History tab provides a record of MID-related activities associated with the selected discrepancy.
Users may access the History tab by selecting History at the top of the MID Detail page.
The History tab may display:
· MID Type 
· Activity Type 
· MID Status 
· Original CSPPID 
· Potential Duplicate CSPPID 
Users should review historical activity before resolving a MID discrepancy.
The History tab can help users understand previous actions performed on record and support resolution decisions.
5.8.3.3	Resolving Multiple Identifier 
Users must select one of the following actions:
Option A: Cancel
Exit without making changes.
Option B: Not a Match
Steps
1. Select Not a Match.
2. Confirm the decision.
3. Save the decision.
Results:
· MID status updates 
· Record is removed from unresolved list.
Option C: Merge
Use when records represent the same child.
Before selecting Merge Records, users should verify that the Original CSPPID and
Potential Duplicate records belong to the same child by reviewing:
· Child Name 
· Date of Birth 
· Gender 
· Program Year 
· LEA information 
· Preschool information 
Merge actions affect child identification data and should only be performed when sufficient evidence exists to confirm a duplicate child record.
Steps:
1. Select Merge.
2. Confirm that both CSPPIDs represent the same child.
3. Select the appropriate CSPPID to retain.
4. Apply the merger.
Result:
· Records are consolidated under one CSPPID. 
· Duplicate identifier is removed. 
· Related records are reassigned.
Important:
· The selected CSPPID becomes the authoritative identifier. 
· Merge is permanent and affects data across LEAs. 
[bookmark: _Toc233628396]5.8.4	Operational Guidance
LEA users should follow these best practices:
· Prioritize External MID discrepancies that involve potential duplicate records across agencies.
· Carefully verify all identifying fields before merging 
· Use Not a Match when evidence is insufficient. 
· Document resolution decisions for audit purposes. 
MID discrepancies are part of overall data validation and may impact certification readiness.
Before certification, users should:
· Review MID Discrepancies alongside Data Discrepancies 
· Resolve all critical MID conflicts. 
· Confirm that merged records maintain data accuracy.


[bookmark: _Certification_Reports][bookmark: _Toc233708129]5.9	Certification Reports
5.9.1	Overview
The Certification Reports section provides LEA users with access to standardized reports that support data validation, verification, and certification readiness. These reports allow users to review aggregated data, confirm completeness, and identify potential inconsistencies prior to certification.
Reports serve as a critical checkpoint in the certification workflow. While the Data Discrepancies page focuses on record-level errors, the Reports section provides a summary-level perspective to ensure that the overall dataset is accurate, reasonable, and aligned with reporting expectations.
LEA users should review certification reports before final certification to confirm that:
· Data totals are complete and consistent. 
· Enrollment counts are aligned with expectations. 
· Trends and distributions appear reasonable. 
· No anomalies remain after discrepancy resolution.
[bookmark: _Toc233628399]5.9.2	Reports Available
The system provides the following standard reports:
· Monthly Child Enrollment by Program Type 
· Monthly Child Enrollment by Statutory Age 
· Monthly Child Enrollment by Contract Type 
Users select a report from the dropdown to generate results.
[bookmark: _6.3_Step-by-Step_Instructions:][bookmark: _Toc233628400]5.9.3	Generating Reports
Steps:
1. Navigate to the Reports section from the left navigation pane or Current Cycle.
Certification > Current Cycle
2. Select the desired report type.
3. Apply any available filters or parameters (such as reporting month).
4. Select Generate Report.
5. Review the report output.
[bookmark: _Toc233628401]5.9.4	How to Use Reports for Certification
LEA users should use reports to:
· Verify totals against internal expectations. 
· Confirm that enrollment counts are reasonable. 
· Identify unusual trends or outliers. 
· Cross-check results after discrepancy resolution. 
[bookmark: _Toc233628402]5.9.5	Relationship to Certification Workflow
Certification Reports are part of the final validation stage of the certification process. They should be used in conjunction with:
· Data Discrepancies (record-level validation) 
· Current Cycle (status and readiness summary) 
· MID Discrepancies (identity validation) 
· Reports do not replace discrepancy resolution but provide an additional layer of data quality assurance.
· 

[bookmark: _Toc233628403][bookmark: _Toc233708130]5.10		Data Exports
5.10.1	Overview
The Data Exports section allows LEA users to extract system data for external review, validation, reporting, and recordkeeping purposes. Exported data can be used to support local analysis, documentation, and audit preparation.
Data exports complement system-based validation by enabling users to:
· Perform offline data review. 
· Maintain records for audit and compliance. 
· Conduct additional analysis outside the system. 
[bookmark: _Toc233628405]5.10.2	Types of Data Exports
The system provides three primary export types:
· Anomaly Data Export – Discrepancy-related data 
· CSPPID Data Export – Child-level identifier data 
· Operational Data Store report (ODS) Data Export – Operational data by record type 
Each export serves a different purpose within the certification and validation workflow.
[bookmark: _Toc233628406]5.10.3	Anomaly Data Export
5.10.3.1	Purpose
The Anomaly Data Export allows users to extract discrepancy-related data, including validation errors and warnings. This export is particularly useful for reviewing outstanding issues outside the system.
5.10.3.2	Requesting an Anomaly Export
Steps:
1. Navigate to the Data Exports page.
2. Select the Anomaly Data Export tab.
3. Complete the required fields:
· Anomaly Type – Select type of discrepancy (or “All”) 
· Filename – Name of the export file 
· Email Address (Optional) – Notification when export is ready. 
· Include Header Row – Option to include column headers. 
4. Select Request Export.
[bookmark: _Toc233628407]5.10.4	CSPPID Data Export
5.10.4.1	Purpose
The CSPPID Data Export provides access to child-level data associated with CSPPIDs. This export supports identity verification and cross-checking across systems.
5.10.4.2	Requesting a CSPPID Export
Steps:
1. Navigate to the CSPPID Data Export tab.
2. Complete the required fields:
· Filename – Desired file name 
· Program Year – Select reporting year. 
· Preschools – Select one or more preschools. 
· Email Address (Optional) – Notification option. 
· Include Header Row – Include column headers. 
3. Select Request Export.
Users can select multiple preschools or use Select All.
[bookmark: _Toc233628408]5.10.5	Operational Data Store (ODS) Data Export
5.10.5.1	Purpose
The ODS Data Export provides access to operational data store records by record type. This export is useful for detailed data validation and system-level review.
5.10.5.2	Requesting an ODS Export
Steps:
1. Navigate the ODS Data Export tab.
2. Complete the required fields:
· Record Type – Select data category. 
· Filename – Output file name 
· Email Address (Optional) – Notification option. 
· Include Header Row – Include headers in export. 
3. Select Request Export.
[bookmark: _Toc233628409]5.10.6	Relationship to Certification Workflow
Data Exports support the certification process by providing external verification tools.
They should be used:
· During discrepancy resolution (for deeper analysis) 
· During report validation 
· Before certification approval 
· For audit documentation 

[bookmark: _Toc233628410][bookmark: _Toc233708131]5.11	Monthly Certification Cycle
LEAs should prioritize Monthly Certification to ensure ongoing data accuracy and reduce end-of-year workload.
Table 1. Three primary certification cycles:
	Phase
	Timeline
	Key Features

	Phase 1 (July 2026)
	Initial rollout
	Monthly certification (Enrollment)

	Phase 2 (Jan 2027)
	Expanded domains
	Attendance added

	Phase 3 (Planned)
	Extended system
	Incident data included


· Fall certification begins: 2027–28 school year.
· EOY certification begins: 2026–27 school year.
5.11.1	Purpose
To validate and certify operational data on a recurring basis.
Applicable Domains (Phase 1 & 2):
· Enrollment Records
· Attendance Information (starting January 2027)
Key Characteristics:
· Occurs monthly during the school year.
· Focused on child and enrollment-related data.
· Supports ongoing data quality monitoring.
Validation Rules:
· Within-domain errors → Block certification
· Cross-domain discrepancies → Allowed but flagged.


[bookmark: _Toc233628411][bookmark: _Toc233708132]5.12	Fall Certification Cycle (Beginning 2027–28)
5.12.1	Purpose
To validate broader program and demographic data early in the academic year.
Domains May Include:
· Child Language Information
· Supplemental DLL Information
· Family Demographics
· Staff Demographics
· Classroom Information
Timing:
· October – December (single window) OR
· October – February (two submission windows; dates to be determined)


[bookmark: _Toc233628412][bookmark: _Toc233708133]5.13	End-of-Year (EOY) Certification Cycle
5.13.1	Purpose
To finalize all reporting data for state and federal requirements.
Domains Include:
· Education Program Participation
· Incident Data (planned phase)
· All remaining domains are not covered monthly.
Timing:
· Begins in the 2026–27 school year.
[bookmark: _1._Certification_Workflow]

[bookmark: _Toc233708134]Appendix List
This list provides additional documents referenced in the CAPSDAC User Manual. It includes the description, links, and resources used throughout the CAPSDAC User Manual.
[bookmark: _Toc157151219][bookmark: _Toc161701379][bookmark: _Toc165888144][bookmark: _Toc165888507][bookmark: _Toc165888611][bookmark: _Toc233708135][bookmark: _Toc161701380]Appendix A Data Definitions
Appendix A contains definitions for all data fields used in the CAPSDAC data collections. Refer to Appendix A – Data Definitions for detailed field description.

[bookmark: _Toc157151220][bookmark: _Toc165888145][bookmark: _Toc165888508][bookmark: _Toc165888612][bookmark: _Toc233708136]Appendix B Data Domain and Fields
Appendix B provides detailed information on data domains, field formats, and file structure requirements used for data submission to the CAPSDAC.

[bookmark: _Toc157151221][bookmark: _Toc161701381][bookmark: _Toc165888146][bookmark: _Toc165888509][bookmark: _Toc165888613][bookmark: _Toc233708137]Appendix C Code Sets
Appendix C provides CAPSDAC data field codes and validation rules for all domains/files.


[bookmark: _Toc233708138]Appendix D Electronic File Format Specifications
Appendix D (insert link) provides an electronic file layout, field order, formatting requirements, and submission specifications for CAPSDAC data files.


[bookmark: _Toc233708139]Appendix D-1 Electronic File Template
Appendix D-1 provides the standard electronic file template for CAPSDAC submissions.


[bookmark: _Toc233708140]Appendix D-2 Electronic File Template with Validation Rule
Appendix D-2 provides the electronic file template with embedded validation rules and some of the data fields’ code dropdown options to assist agencies in preparing data submissions.


[bookmark: _Toc233708141][bookmark: _Toc161701384][bookmark: _Toc165888149][bookmark: _Toc165888512][bookmark: _Toc165888616]Appendix E Error Messages
Appendix E contains descriptions of CAPSDAC error messages, their associated data fields, common causes, troubleshooting guidance, and references to related instructional materials.


[bookmark: _Toc233708142]Appendix F Consultant and Analyst Procedures
Appendix F Consultant and Analyst Directories provide procedures, responsibilities, and reference materials for CAPSDAC consultants and analysts.


[bookmark: _Toc233708143]Appendix G State Median Income Guidance
Appendix G provides the current State Median Income guidance, including the Schedule of Income Ceilings and Income Ranking Table.
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